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FCC Statement

 

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses and can radiate radio frequency energy and if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. However, there is 
no guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio and television reception, which can be determined by 
turning the equipment on and off, the user is encouraged to try to correct the interference by 
one or more of the following measures:

 

■

 

   Reorient or relocate the receiving antenna.

 

■

 

   Increase the separation between the equipment and the receiver.

 

■

 

   Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

 

■

 

   Consult the dealer or an experienced radio/TV technician for help.

 

Shielded cables and I/O cards must be used for this equipment to comply with the relevant 
FCC regulations. Changes or modifications not expressly approved in writing by Connectix 
Corporation may void the user’s authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation.



 

iii

 

FCC Statement .......................................................................................................................................................... ii

 

CHAPTER 1: About Connectix QuickCam

 

What is Connectix QuickCam?............................................................................................................................1-1
What does your QuickCam do? ...........................................................................................................................1-1

Adds live video input to your computer.........................................................................................................1-1
Adds a digital still camera to your Macintosh ...............................................................................................1-1
Makes your Macintosh fun again!...................................................................................................................1-1

What is VIDEC? .....................................................................................................................................................1-2
Who should use QuickCam?................................................................................................................................1-2

 

CHAPTER 2: Getting Started

 

What’s in the box....................................................................................................................................................2-1
System Requirements ............................................................................................................................................2-1

Grayscale QuickCam........................................................................................................................................2-1
Color QuickCam...............................................................................................................................................2-2

Compatibility .........................................................................................................................................................2-2
Grayscale QuickCam........................................................................................................................................2-2
Color QuickCam...............................................................................................................................................2-2

Installing your QuickCam ....................................................................................................................................2-2
Grayscale QuickCam........................................................................................................................................2-2
Color QuickCam...............................................................................................................................................2-3

Installing QuickCam’s software............................................................................................................................2-4
Easy Install .........................................................................................................................................................2-4
Custom Install ...................................................................................................................................................2-5

What QuickCam copies to your hard disk..........................................................................................................2-6
QuickCam folder ..............................................................................................................................................2-6
System folder .....................................................................................................................................................2-6

 

CHAPTER 3: Using Your QuickCam

 

The parts of your Connectix QuickCam.............................................................................................................3-1
How to focus your QuickCam .............................................................................................................................3-2
Using Grayscale and Color QuickCams at the same time.................................................................................3-2
About Connectix QuickCam’s software ..............................................................................................................3-2

 

CHAPTER 4: Getting The Best Image and Frame Rate

 

Making sure there is enough light........................................................................................................................4-1
Adjusting the image settings .................................................................................................................................4-1

Choosing the correct serial port (Grayscale, Color) .....................................................................................4-3
Adding special effects (Grayscale, Color) .......................................................................................................4-3
Adjusting the brightness of the image (Grayscale, Color)............................................................................4-3
Choosing a Light Meter (Grayscale, Color) ...................................................................................................4-4
Adjusting the Sharpness (Grayscale, Color) ..................................................................................................4-5
Adjusting the hue of the image (Color Only)................................................................................................4-5
Adjusting the Black Level and Saturation (Color Only)...............................................................................4-5
Low-Light Image Correction (Color Only)...................................................................................................4-6

How to get the best frame rate in QuickMovie ..................................................................................................4-7

 

CHAPTER 5: Taking Pictures with QuickPICT

 

About QuickPICT..................................................................................................................................................5-1
Taking a picture - basic steps ................................................................................................................................5-2

 

CONTENTS

 

 

This document was created with FrameMaker 4.0.4



 

iv

 

Contents

 

Taking the picture............................................................................................................................................. 5-2
Using the Viewer.................................................................................................................................................... 5-2
Choosing where to save your picture .................................................................................................................. 5-2

Saving the picture to the clipboard ................................................................................................................ 5-3
Saving the picture to a file ............................................................................................................................... 5-3
Saving the picture to the Film Roll................................................................................................................. 5-4
Changing the location of the Film Roll files.................................................................................................. 5-5

Picture-taking options .......................................................................................................................................... 5-5
Selecting an image area.................................................................................................................................... 5-5
Changing the size of a picture......................................................................................................................... 5-6
Changing the picture depth ............................................................................................................................ 5-6
Zooming the image.......................................................................................................................................... 5-7
Changing the shutter mode ............................................................................................................................ 5-7
Using the self-timer.......................................................................................................................................... 5-8

Taking pictures automatically .............................................................................................................................. 5-9
Auto-Capture — Saving to the same file..................................................................................................... 5-10
Auto-Capture — Saving a file series ............................................................................................................ 5-10
Auto-Capture — Advanced options ............................................................................................................ 5-10

Taking multiple exposures.................................................................................................................................. 5-11
Switching between cameras................................................................................................................................ 5-12

 

CHAPTER 6: Recording Movies with QuickMovie

 

About QuickMovie ............................................................................................................................................... 6-1
Starting QuickMovie............................................................................................................................................. 6-1

Switching between Record and Edit modes .................................................................................................. 6-1
QuickMovie’s Controls......................................................................................................................................... 6-2

Controls for recording ..................................................................................................................................... 6-2
Notes about setting brightness........................................................................................................................ 6-2
Controls for editing.......................................................................................................................................... 6-2

Audio-recording options...................................................................................................................................... 6-4
Choosing a microphone.................................................................................................................................. 6-4
Choosing a sampling rate................................................................................................................................ 6-4
Turning off audio recording............................................................................................................................ 6-4

Video-recording options ...................................................................................................................................... 6-5
Normal recording............................................................................................................................................. 6-5
Stop-action recording...................................................................................................................................... 6-5
Time-lapse recording....................................................................................................................................... 6-5
Turning off video recording............................................................................................................................ 6-5

Recording a movie................................................................................................................................................. 6-5
Viewing a movie .................................................................................................................................................... 6-6
Saving a movie....................................................................................................................................................... 6-6
Opening a movie you have saved ........................................................................................................................ 6-6
Editing a movie...................................................................................................................................................... 6-6

Adding video into a movie.............................................................................................................................. 6-6
Selecting a section of video ............................................................................................................................. 6-7
Replacing video in an existing movie............................................................................................................. 6-7
Deleting part of an existing movie ................................................................................................................. 6-7
Duplicating a section within a movie ............................................................................................................ 6-8
Moving a section within a movie ................................................................................................................... 6-8
Copying video from one movie to another................................................................................................... 6-8

A note about display size ...................................................................................................................................... 6-9
About frame rates.................................................................................................................................................. 6-9
About video compression..................................................................................................................................... 6-9

Compressing a video while recording............................................................................................................ 6-9



 

v

 

Compressing a color movie so that other people can view it ....................................................................6-10
About flattening QuickTime movies ............................................................................................................6-10
Using Compress Movie to create a compressed and flattened movie.......................................................6-11

 

CHAPTER 7: Using the QuickSaver Utility

APPENDIX A: Camera Specifications

 

Grayscale QuickCam ............................................................................................................................................ A-1
Color QuickCam................................................................................................................................................... A-1

 

APPENDIX B: Important Information About The Apple Desktop Bus (ADB)

 

What is the Apple Desktop Bus?.......................................................................................................................... B-1
How do I connect devices to the ADB? .............................................................................................................. B-1
PowerBooks, Sleep Mode, and the ADB............................................................................................................. B-2
How long can the ADB cable be? ........................................................................................................................ B-2
How does Connectix QuickCam use the ADB? ................................................................................................ B-2

 

APPENDIX C: Frequently Asked Questions

APPENDIX D: Support and Sales

 

Contacting Connectix Support ...........................................................................................................................D-1
Contacting Connectix Sales .................................................................................................................................D-2
Contacting Connectix Support in Europe .........................................................................................................D-2

European Addresses.........................................................................................................................................D-2

 

APPENDIX E:  Warranty



 

vi

 

Contents



 

About Connectix QuickCam

 

1-1

 

1

 

ABOUT 
CONNECTIX 
QUICKCAM

 

What is Connectix QuickCam?

 

Connectix QuickCam is a digital camera that plugs right into your computer. You don’t 
need any other hardware! There are both Grayscale and Color models. Both come with 
software you can use to take pictures and record movies and sound. 

 

What does your QuickCam do?

 

Adds live video input to your computer

 

Your QuickCam is an inexpensive way to add live video to your Macintosh. QuickCam’s 
software allows you to capture and edit QuickTime movies conveniently. The Color 

QuickCam has VIDEC

 

TM 

 

(

 

V

 

ideo

 

 D

 

igitally 

 

E

 

nhanced 

 

C

 

ompression) built into the camera 
head to give even faster video frame rates in larger frame sizes.

For an affordable videoconferencing solution, use your QuickCam with 

 

Connectix 
Videophone

 

 software.

 

Adds a digital still camera to your Macintosh

 

Share your life with a friend or family member. Use QuickCam to digitize photos, a favorite 
cartoon, or take your own picture to send over the Internet. QuickCam’s software includes 
the ability to take photos in PICT, TIFF or JPEG format. Use QuickCam to quickly 
prototype stills, do “for position only” comps, or to add laser-printer quality graphics to 
your newsletters or documents. 

You can use QuickCam with

 

 Connectix PhotoMate

 

 to take and enhance pictures and 
create and play custom slide shows.

 

Makes your Macintosh fun again!

 

QuickCam works with any software that works with QuickTime or standard Macintosh 
PICTs. For personalized multimedia greetings, use QuickCam with 

 

Connectix 
QuickCards

 

. Don’t just send a card next holiday season — send a QuickCard with a 
QuickTime movie of the whole family!
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About Connectix QuickCam

 

What is VIDEC?

 

VIDEC

 



 

 (Video Digitally Enhanced Compression) was created by Connectix to compress 
video data inside the Color QuickCam, 

 

before

 

 the data reaches your computer. VIDEC 
yields higher video frame rates while you are recording, and results in smaller file sizes 
when you save video. You don’t need any additional video hardware to get the benefits of 
VIDEC.

 

Who should use QuickCam?

 

■

 

People Who Want to Keep Updated Images on Their Web Page

 

Use QuickCam’s Auto-Capture feature, described on page 5-9, to see how you can use 
your Color QuickCam to automatically update the images on your Web page.

 

■

 

Presentation Makers Looking to “Jazz Up” Their Creations

 

Good presentations use graphics. QuickCam can quickly produce both QuickTime 
movies and PICT, TIFF or JPEG graphics.

 

■

 

Videoconferencing Users Looking for a Low-Cost Camera 

 

QuickCam’s low price and ease of use makes it simple to get started with video confer-
encing. QuickCam’s QuickTime-standard software means that it will work with virtu-
ally any videoconferencing software, such as Connectix VideoPhone.

 

■

 

Multimedia Producers Who Need to Quickly Prototype

 

QuickCam allows you to produce prototype-quality visuals without the setup hassle 
normally associated with alternative equipment.

 

■

 

Your Idea Here!

 

Since QuickCam is a standard QuickTime input device, it works with any QuickTime 
capable software! Here are some ideas to get you started:

• Make a multimedia greeting card with Connectix QuickCards Limited
•  Mail a floppy video
• E-mail a picture from your vacation to a friend
• Star in your screen saver
• Watch a flower bloom
• Make a photo collage
• Dress up your desktop
• Verify inventory
• Add pictures to your holiday letters
• Guard your office 
• Watch over things while you’re away
• Create a family tree using pictures
• Make training movies
• Add pictures to your contact database
• Punch up your newsletter
• Sell your house or car
• Create moving videos of models instead of using 3D software

If you do something unique or creative with QuickCam, we’d like to hear about it. Send 
email comments to quickcam@connectix.com. 



 

Getting Started

 

2-1

 

2

 

GETTING 
STARTED

 

What’s in the box

 

– Grayscale or Color QuickCam

– Triangular base

– 2 Installation disks 

– This manual

– Registration card

 

System Requirements 

 

Make sure that your system meets the following minimum requirements. For best results, 
you should have a system that meets the recommended configuration (the items in the 
right-hand column).

 

Grayscale QuickCam

 

Minimum Configuration Recommended

 

 

 

Configuration

CPU

 

68020 processor 68040 Macintosh or faster

 

System

 

System 7.1 System 7.5 or later

 

RAM

 

4 MB 8 MB

 

Hard Disk 

 

2 MB hard disk space required for 
QuickCam software; additional 5 
MB disk space needed to create 
movies. 

Same as minimum

 

Serial Port

 

One free serial port Same as minimum

 

Display

 

Grayscale or color monitor Same as minimum
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Getting Started

 

Color QuickCam

 

NOTE:

 

 If you have a Color QuickCam, you will need an external microphone if you want 
to record sound with your movies. If you do not have a microphone, you can still record 
movies, but they will not have audio. (The Grayscale QuickCam has a built-in 
microphone.)

 

Compatibility

 

Grayscale QuickCam

 

The following Macintosh models are not compatible with Connectix Grayscale 
QuickCam: Mac Plus, Mac SE, PowerBook 100.

 

Color QuickCam

 

The following Macintosh models are not compatible with Connectix Color QuickCam: 
Mac Classic, Mac Plus, Mac SE, PowerBook 100, PowerBook 150, and Mac Portable.

 

Installing your QuickCam

 

Grayscale QuickCam 

 

1 .   

 

Shut down your Mac.

 

2 .

 

Remove the camera from the box and plug the cable to a serial port on your Mac. The 
camera is designed to sit on the supplied triangular base. Place the base on your 
desktop, atop your monitor, or any other convenient position, then place the camera 
on the base.

 

Minimum Configuration Recommended

 

 

 

Configuration

CPU

 

68040 processor Power Macintosh

 

System

 

System 7.1 System 7.5 or later

 

RAM

 

8 MB Same as minimum

 

Hard Disk 

 

2 MB hard disk space required for 
QuickCam software; additional 5 
MB disk space needed to create 
movies. 

Same as minimum

 

Serial Port

 

One free serial port Same as minimum

 

ADB Port

 

One ADB port required Same as minimum

 

Display

 

Monitor capable of displaying 256 
colors 

Monitor capable of displaying 
thousands of colors

 

Audio 

 

External microphone for recording, 
speakers for audio playback

Same as minimum
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3 .

 

Restart your Macintosh and hold down the Shift key to disable all extensions such as 
virus protection.

 

4 .

 

Follow the instructions on page 2-4 for installing QuickCam’s software.

 

Color QuickCam 

 

1 .   

 

Shut down your Mac.

 

2 .

 

Remove the camera from the box.

 

3 .

 

Your Color QuickCam has two plugs, as shown in the figure on the next page. The “T” 
plug attached to the small cable is the power plug, and will attach to the ADB (

 

A

 

pple 

 

D

 

esktop 

 

B

 

us, for a keyboard or mouse) port of your Macintosh.

 

4 .

 

Unplug your keyboard or mouse and insert the Color QuickCam T plug into the ADB 
port on your Macintosh. Now plug your keyboard or mouse into the back of the Color 
QuickCam ADB connector.

 

5 .

 

The plug with the two cables coming out of it will carry the video from the camera to 
your Macintosh. Insert it into either your printer or modem serial port.

WARNING: You will need to plug your Color QuickCam into your 
Macintosh’s ADB port. You should NEVER change any connection to 
the ADB port unless the power to your Macintosh is switched OFF, 
otherwise you may damage your computer’s logic board.
DO NOT unplug your mouse or keyboard from the ADB port until 
you have switched the power off.

Plug this end into the Modem or Printer 
serial port on the back of your Macintosh

Plug this end of the T into the ADB 
port on the back of your Macintosh

Plug other ADB devices (keyboard and
 mouse) into this end of the T connector
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6 .

 

The camera is designed to sit on the supplied triangular base. Place the base on your 
desktop, atop your monitor, or any other convenient position, then place the camera 
on the base.

 

7 .

 

Turn on your Macintosh and hold down the Shift key to disable all extensions such as 
virus protection.

 

8 .

 

Follow the instructions below for installing QuickCam’s software.

 

Installing QuickCam’s software

 

1 .   

 

Insert the QuickCam installation disk #1 and double-click the QuickCam Installer 
icon.

 

2 .

 

This brings up the QuickCam Installer dialog, shown below. You can choose 

 

Easy Install

 

 for the basic installation, or 

 

Custom Install

 

 for more control over which 
files are installed.

 

Easy Install

 

3 .

 

Choose 

 

Easy Install

 

 from the menu at the top. Click 

 

Install

 

 to continue.
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4 .

 

In the dialog shown below, select the Color or Grayscale QuickCam (or both) and 
click the serial port to which each is attached.

 

5 .

 

Click 

 

Install

 

 to continue. You will need to restart your Mac after the installation. 

 

Custom Install

 

1 .   

 

Choose Custom Install from the menu at the top of the dialog.

 

2 .

 

Click in the check box to the left of an item to install it. Click on the

 

 

 

 button to 

the right of an item to find out more about it.

 

3 .

 

Next, choose the folder in which you want to install QuickCam software with the 

 

Select Folder

 

 button. The installer tells you how much space is available on the drive 
and how much space is needed by the QuickCam software you’ve chosen to install.

 

4 .

 

If you have chosen to install the Grayscale or Color QuickCam Extensions, select the 
Color or Grayscale QuickCam (or both) in the dialog that appears, and click the serial 
port to which each is attached. 
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5 .

 

Click the 

 

Install

 

 button. QuickCam will prompt you to insert the second installation 
disk. 

 

6 .

 

If you use one port and you get an error message, try moving the camera to the other 
port. 

If your QuickCam is installed on a PowerBook with one serial port and an internal 
modem, set the modem to 

 

Compatible 

 

mode. This option is located in the PowerBook 
Setup control panel. AppleTalk needs to be inactive on the serial port in order to make the 
port available for QuickCam. However AppleTalk can be active on another physical port, 
such as an Ethernet port.

On some PowerBooks (such as the 500 series and Duos), only one physical connector 
supports two logical ports (modem and printer). On a docked Duo, when you are asked to 
select the port to which your QuickCam is connected, choose the modem port. On a 
PowerBook 500 series Macintosh, the QuickCam installer will automatically select the 
modem port.

If you are using a Mac IIfx, Quadra 900, or a Quadra 950, the Serial Switch Control Panel 
must be set to 

 

compatible

 

 (not 

 

faster

 

). If it is not present, the Serial Switch Control Panel 
will be installed for you.

 

7 .

 

Follow the on-screen prompts until the dialog box tells you QuickCam has been 
installed and asks you to restart your Macintosh. Click 

 

OK

 

. You are now ready to use 
your camera. 

 

Important: 

 

You will need to restart your computer to make sure QuickTime and the 
QuickCam software are active.

 

What QuickCam copies to your hard disk

 

QuickCam folder

 

QuickMovie and QuickPICT applications.

 

System folder

 

– The ~QuickCam Mic extension (Grayscale QuickCam)

– The ~QuickCam Video extension (Grayscale QuickCam)

– The 

 

~

 

Color QuickCam system extension (Color QuickCam)

NOTE: Port Busy? Some communications software packages register 
a port as being busy even when it is not active. Unfortunately, 
QuickCam’s software has no way of telling whether a “port busy” 
message is accurate or not. If the installation software says that you 
have a port in use, you’ll either need to install to the other port or find 
the software that is active on that port and de-activate it. For technical 
support information, see Appendix D.
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– The VIDEC

 

TM

 

 compression decoder, called “VIDEC” (Color QuickCam)

– A QuickSaver module is added to your AfterDark Files folder if you have one; otherwise 
it is placed in the QuickCam folder.

– The QuickTime 2.5 extension is placed in your Extensions folder if it wasn’t already 
there or if the installer found an older version. 

– If you have a Power Macintosh, the Power Macintosh addition to QuickTime, called 
QuickTime PowerPlug, is also added to your Extensions folder.

– Sound Manager 3.2.1

– If you have a Mac IIfx, a Quadra 900, or a Quadra 950, the Serial Switch Control Panel 
is added if it is not already present. 

– An alias of the QuickPICT application is also added to the Apple Menu.
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USING YOUR 
QUICKCAM

 

The parts of your Connectix QuickCam

 

The Connectix QuickCam is a simple device that has no user-serviceable parts. Both Color 
and Grayscale models are available. There are several differences between the two models:

 

■

 

The Grayscale QuickCam has a microphone; the Color QuickCam does not. 

 

■

 

The Color QuickCam has a focusing ring; the Grayscale QuickCam has a fixed focus.

If you have a Color QuickCam, it will look like the one in the picture below.

If you have a Grayscale QuickCam, it will look like the picture below.

Camera lens

Standard tripod mount 
(at bottom of sphere)

Focusing ring

Camera base

Standard tripod mount 
(at bottom of sphere)

Camera lens

Microphone grille

Camera base
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Using Your QuickCam

Put the camera base in a convenient spot on your desk or monitor, and then adjust the 
direction in which the camera is pointing. If the camera moves unexpectedly in the base, 
make sure there is no tension on the cable.

You can also mount QuickCam on any standard camera tripod mount. Connectix sells a 
small desktop tripod that works well with QuickCam; camera stores should also have small 
tripods that fit your QuickCam.

 

How to focus your QuickCam

 

The Grayscale QuickCam has a fixed focus from eighteen inches to infinity. You can adjust 
the focus on your Color QuickCam from one inch to infinity by turning the focusing ring 
on the outside of the lens until the image is sharp. 

 

Using Grayscale and Color QuickCams at the 
same time

 

You can have both color and Grayscale QuickCams attached at the same time, as long as 
you have two open serial ports. You can easily switch between them at any time. 

 

■

 

To switch to the Grayscale QuickCam, choose 

 

Connectix QuickCam 

 

from the 

 

Settings

 

 
menu, then choose 

 

Modem 

 

or 

 

Printer

 

 port, depending on the port to which the camera 
attached. 

 

■

 

To switch to the Color QuickCam, choose 

 

Connectix Color QuickCam 

 

from the 

 

Settings

 

 menu, then choose 

 

Modem 

 

or 

 

Printer

 

 port, depending on the port to which 
the camera attached.

 

About Connectix QuickCam’s software

 

When you install your Connectix QuickCam, it copies two applications to your hard disk:

 

■

 

QuickPICT

 

 is an application for capturing still images, and is described in chapter 5.

 

■

 

QuickMovie 

 

is an application for capturing QuickTime video, and is described in 
chapter 6.

You also get the 

 

QuickSaver

 

 utility for using the image from your QuickCam as a 
screen-saver. To use 

 

QuickSaver

 

, you must have After Dark or Darkside installed. 

 

QuickSaver

 

 is described in chapter 7. 
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GETTING THE 
BEST IMAGE AND 
FRAME RATE

 

There are two steps to getting the best image for QuickPICT and QuickMovie. First, make 
sure that you have enough light on the scene. Once you have enough light, adjust 
QuickCam’s image settings to fine-tune your image.

 

Making sure there is enough light

 

To get the best image from your QuickCam, first make sure that you have adequate 
lighting. All of the other image adjustments depend on the presence of an adequate 
amount of light. As a rule of thumb, if the lighting is such that you would use a flash with 
a normal 35mm camera, you need to add more light for your QuickCam. This is probably 
true in most home environments where illumination is provided by a single light.

 

Adjusting the image settings

 

To adjust the image, choose 

 

Camera Settings

 

 from the 

 

Image 

 

menu, then choose 

 

QuickCam

 

 from the pull-right menu. The video settings dialog will appear, as shown on 
the next page. The appearance of the dialog is different for the Color and Grayscale 
QuickCams. 

 

■  

 

If you make changes in the video dialog and you want to start over, click the 

 

Defaults

 

 
button to restore default settings. 

 

■  

 

When you are done adjusting settings, click 

 

OK

 

 to accept your choices and dismiss the 
dialog.

 

NOTE: 

 

You do not need to choose 

 

Video Other  

 

from the Camera Settings menu unless 
you are using an NTSC Camera with an AV Macintosh. 
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Getting The Best Image and Frame Rate

If you are using a color QuickCam, the settings dialog will appear as shown below.

If you are using a Grayscale QuickCam, the dialog will appear as shown below. 
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Choosing the correct serial port (Grayscale, Color)

 

Use the 

 

Input

 

 pull-down menu to set the serial port to which your QuickCam is 
connected.

 

Adding special effects (Grayscale, Color)

 

■  

 

To flip the image upside-down, click the 

 

Flip

 

 checkbox. The image at the right of the 
dialog will be flipped. This is useful if you want to turn your QuickCam upside down.

 

■  

 

To create a mirror image, click 

 

Mirror

 

. The image at the right will be mirrored. 

 

■  

 

To rotate the image 90 degrees (from Landscape to Portrait orientation), click 

 

Rotate 
90 degrees

 

. This change will only take effect after you quit and re-start QuickPICT or 
QuickMovie.

 

Adjusting the brightness of the image (Grayscale, Color)

 

To adjust the brightness of the image, use the 

 

Brightness

 

 and 

 

White Level

 

 sliders. If you 
choose 

 

Auto Brightness

 

, QuickCam will adjust both of these values automatically, and 
their respective sliders will be grayed-out.

 

■  

 

The 

 

Brightness

 

 slider determines the shutter speed.

– If the picture you see looks washed out or entirely white, move the slider to the left to 
lower the amount of light reaching the camera. 

– If the picture you see looks dark or is almost entirely black, move the slider to the right 
to let more light into the camera. 

– If there is not enough light to take a picture, the Light Meter symbol will flash every 
second at the bottom of the window. 

You can also change the brightness in smaller increments by clicking the left or right 
arrow keys.

NOTE: Some items in the video settings dialog are present for both the Color and 
Grayscale QuickCam; others are present only for the Color QuickCam. In the 
descriptions below, items are marked as follows:

■ Items common to both Grayscale and Color QuickCam: (Grayscale, Color)

■ Items found only in the Color QuickCam dialog: (Color Only)

This symbol will appear
if there is not enough light
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Getting The Best Image and Frame Rate

– If you see lots of colored pixels, the picture is too dark. You need to increase the lighting 
level in the room and make sure the Low-Light Image Correction is turned on. See page 
4-6 for more information.

– If you select 

 

Auto Brightness

 

 , you will not need to make any changes with the slider.

 

■  

 

White Level.

 

 This sets the value of white in your picture. To adjust it manually, take a 
white item such as a piece of paper and hold it in front of the camera. Begin with the 

 

White Level

 

 slider all the way to the left, and move it to the right until the white item 
just begins to appear white.

 

Choosing a Light Meter (Grayscale, Color)

 

Use the 

 

Light Meter

 

 pull-down menu to choose how QuickCam measures light when it is 
automatically setting the brightness. 

 

■  

 

If you choose 

 

Entire Frame

 

, QuickCam will sample the entire image to determine the 
best average brightness setting. If the background is very much lighter than the center 
of the image, you may not get best results with this setting. For example, if you are using 
your QuickCam to videoconference and you are sitting near a bright window, your face 
may be washed out.

 

■  

 

If you choose 

 

Center Weighted

 

, the Light Meter will assign more weight to the 
brightness at the center of the image. This means that a bright area on the periphery 
will not overwhelm the area at the center. 

 

■  

 

If you choose 

 

Center Only

 

, the Light Meter will sample the center only, and will ignore 
the areas at the periphery. If you are videoconferencing, this will probably yield the best 
results.

If you are using a Color QuickCam, you will also begin to see random colored pixels 
(Holiday lights). If this happens, you need to increase the amount of light and select 

 

Low-light image correction

 

, described on page 4-6.

TIP: When you first start QuickPICT or QuickMovie, choose Camera Settings from 
the Image menu, then choose QuickCam. In the dialog that appears, choose Auto 
Brightness. This lets QuickCam find the best setting for your picture. Since this value 
probably won’t change much, you can then de-select Auto Brightness to allow you to 
fine-tune the Brightness value.
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Adjusting the Sharpness (Grayscale, Color)

 

Use the pull-down menu to choose a Sharpness level. 

 

■  

 

If you choose 

 

High

 

 sharpness, the picture will look crisp and edges will be well-defined, 
but frame rates will be lower. Choose this for the best quality images.

 

■  

 

If you choose 

 

Medium

 

 sharpness, QuickCam will use 2:1 decimation, which means 
that it will send every other pixel from the camera. The picture will not be as sharp, but 
frame rates will increase somewhat. This is a good setting for videoconferencing, but 
you will get better frame rates by choosing 

 

Low

 

 sharpness.

 

■  

 

If you choose 

 

Low

 

 sharpness, QuickCam will use 4:1 decimation, which means that it 
will send every other pixel 

 

and

 

 every other horizontal line from the camera. The picture 
will appear somewhat blurry or pixellated, but frame rates will be highest. This is 
probably the best setting if you are using your QuickCam for videoconferencing, 
especially if you are using a 28.8 modem.

 

Adjusting the hue of the image (Color Only)

 

To adjust the hue of the image, use the 

 

Red

 

 

 

Level

 

 and 

 

Blue Level

 

 sliders. If you choose 

 

Auto 
Hue

 

, QuickCam will set both of these values automatically, and their sliders will be 
grayed-out.

 

■  

 

Red Level.

 

 This adjusts the level of red in your image. If there is too much red, move 
the slider to the left. If there is not enough red, move the slider to the right. 

 

■  

 

Blue Level. 

 

This sets the level of blue in your image. If there is too much blue, move the 
slider to the left. If there is not enough blue, move the slider to the right. 

The amount of green is fixed, and can be increased by lowering the relative amounts of red 
and blue.

 

Adjusting the Black Level and Saturation (Color Only)

 

■  

 

Black Level. 

 

This sets the value of black in your picture. Take a black item and hold it 
in front of the camera. Begin with the Black Level slider all the way to the left, and move 
it to the right until the black item just begins to appear black.

 

■  

 

Saturation.

 

 This determines how intense the color is. The further to the left, the more 
washed-out the colors will appear. If a light source in the picture shows a blurring or 
icicle effect, decrease the Saturation. An example of blurring and the appearance of 
icicles is shown on the next page.

TIP: If you move your QuickCam from a setting with fluorescent lights 
to one with incandescent lights, try using the Auto-Hue setting or 
decreasing the Red Level for incandescent light. If you move your 
QuickCam back to a setting with fluorescent lights, increase the Red 
Level.
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Here is the same picture with a reduced Saturation level. Note how the icicles and blurring 
have disappeared.

 

Low-Light Image Correction (Color Only)

 

This box should be checked to prevent the random appearance of colored pixels at low 
light levels. In order to capture images at low light levels, your QuickCam, like any camera, 
requires longer exposures. One side-effect of this situation is known as 

 

dark current

 

, where 
the CCD in the QuickCam picks up random charges during a long exposure. These charges 
build up and cause some pixels to display color (Holiday lights). The longer the exposure, 
the more this effect will be apparent.

If you turn off this checkbox, you will see the colored pixels at low light levels. An extreme 
example is shown on the next page. 

Fluorescent light

Window shade

Icicles

Fluorescent light

Window shade
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. 

 

How to get the best frame rate in QuickMovie

 

Maximizing the frame rate is important in many situations, especially if you are using your 
QuickCam for videoconferencing. Here are some tips for increasing the frame rate:

 

■  

 

One of the most important factor in getting the highest possible frame rate is 

 

having 
enough illumination

 

. The less light there is, the longer the shutter will have to stay open 
to capture each frame, and subsequently the lower the frame rate. Simply by increasing 
the light level, you can decrease the necessary shutter speed (the Brightness setting) and 
increase the frame rate. 

 

■  

 

Make sure that your monitor is set to 

 

display the same number of colors or grays as the 
QuickCam is capturing

 

. For example, if you capture video at thousands of colors , 
make sure your monitor is set to display thousands of colors. If your monitor displays 
16 grays, capture video at 16 grays. If the QuickCam has to dither the image to match 
your display, frame rates will decrease.

– If you are using a Grayscale QuickCam, you will probably get the best frame rates at 16 
grays or less (16 grays is the default setting).

– If you are using a Color QuickCam, use thousands of colors (the default setting). In this 
mode, Color QuickCam implements VIDEC

 

TM

 

 (Video Enhanced Digital 
Compression), which will increase frame rates.

– If you need to change the color depth, choose 

 

Camera Settings

 

 from the 

 

Image

 

 menu, 
then choose 

 

Video other

 

. In the dialog that appears, choose 

 

Compression

 

 from the 
popup menu. Choose a compressor and use the 

 

Depth

 

 menu to select the color depth. 
(

 

NOTE

 

: VIDEC only operates at thousands of colors.)

 

■  

 

If there is enough light, you may get increased frame rates if you turn off the

 

 Low-Light 
Image Correction

 

 checkbox in the Camera Settings dialog.

 

■  

 

If you do not need the maximum amount of detail in each frame, 

 

choose a reduced 
Sharpness level

 

. If you choose the middle or the lowest value for Sharpness, you will get 
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higher frame rates than if you choose the highest Sharpness value. See page 4-5 for 
more information about setting the Sharpness level.

 

■

 

Choose a smaller image size

 

. Capturing a smaller image size results in faster frame 
rates.

 

■  

 

Turn 32-bit addressing on

 

. Most newer Mac models are always in 32-bit addressing 
mode. Older Mac models have 32-bit addressing as an option in the Memory Control 
Panel. If your Memory Control Panel lacks a 32-bit addressing option, one of the 
following three cases applies:

– It is a newer Macintosh model, such as a Quadra 630 or Power Mac, which is always in 
32-bit addressing mode.

– It is a Mac II, IIx, IIcx or SE/30 which needs to use Connectix MODE32 7.5 to run 
32-bit addressing. MODE32 is available at the online locations listed in Appendix D.

– It is a 68000-based Macintosh that is not capable of 32-bit addressing.

 

■

 

Use QuickTime 2.5

 

 instead of earlier versions. Use QuickTime PowerPlug on Power 
Macintosh models.

 

■

 

Don’t move the mouse 

 

while recording a movie.

 

■

 

Turn off all software INITs

 

 or extensions that might interrupt the movie recording 
process. Disable AppleTalk or any network connection, turn off Virtual Memory, turn 
off Fax and Modem software, and use an Extensions manager to turn off any other 
extension that might cause periodic background processing to occur, including screen 
savers and security applications. Make certain that there is nothing periodically 
sending information to the serial port to which your QuickCam is attached.

 

■

 

Make sure you’re running only QuickMovie

 

. Close any other application, control 
panel, or desk accessory you might have open.

 

■

 

Put a disk in the floppy disk drive

 

 (if no disk is present, your Mac checks periodically 
to see if you have inserted one). If you have a CD-ROM drive, insert a disk or disable 
the drive by removing its INIT and restarting.

 

■  

 

Make sure you’re 

 

using your highest performance hard disk

 

 and have disabled any idle 
drives in the SCSI chain. It also helps if you keep your hard disk defragmented by 
running an optimization program on it prior to capturing video. Alternatively, record 
to a RAM disk, which provides a faster storage medium than a hard disk.
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5

 

TAKING PICTURES 
WITH QUICKPICT

 

About QuickPICT 

 

Use QuickPICT to capture still color images and save them in JPEG, TIFF, or PICT format.
To start QuickPICT, double-click its icon. 

The QuickPICT window will appear as shown below. 

This window shows what the camera is currently seeing, just like the viewfinder of a 
regular camera. 

Click here to
choose where
to save your
picture Use the slider

to adjust the
brightness

Click here to
take a picture

Click here to 
quit QuickPICT

Click here to
toggle the
window size

Click and drag
here to change
window size

Click the arrows to
adjust brightness in
smaller increments

 

 

This document was created with FrameMaker 4.0.4



 

5-2

 

Taking Pictures with QuickPICT

 

Taking a picture - basic steps

 

1 .  

 

Make sure you have enough light. See Chapter 4 for a complete discussion of how to 
adjust the brightness and other settings to get the best quality image.

 

2 .  

 

If you are using a Color QuickCam, use the focus ring to focus your picture.

 

3 .  

 

Smile!

 

Taking the picture

 

To take a picture, click the

 

 Take Picture

 

 button. QuickPICT will grab the current image 
and convert it into a PICT file. If the button at the bottom left is a clipboard, the picture 
will be copied to the clipboard; if the button is a disk, a dialog will appear where you can 
choose where to save the file; if the button is a Film Roll, the picture(s) will appear in the 
Film Roll. 

For more control over how QuickPICT takes pictures, see 

 

Picture-taking options 

 

beginning 
on page 5-5.

 

Using the Viewer

 

The Viewer is a separate window in which QuickPICT displays a picture. It displays the 
most recent picture you have taken, no matter where you are saving the picture. It will also 
show a picture you have double-clicked in the Film Roll (see page 5-4). To show or hide 
the Viewer, choose 

 

Show Viewer

 

 or 

 

Hide Viewer

 

 in the 

 

Window

 

 menu.

You can also save or copy the image in the Viewer.

 

■

 

To save the image, select the Viewer by clicking it, then choose 

 

Save As

 

 from the file 
menu. Enter a name in the Save dialog, choose a file format, and click 

 

Save

 

. The Save 
dialog is described on page 5-3.

 

■

 

To copy the image in the Viewer, select the Viewer by clicking it, then choose 

 

Copy

 

 from 
the 

 

Edit

 

 menu. You can then paste the image into another application.

 

Choosing where to save your picture

 

You can save your picture to a file, to the clipboard, or to the film roll. To toggle between 
these locations, click the button at the bottom left of the window. The button will change 
to show where the picture will be saved. The buttons are shown below.

The picture will be
saved to a disk file

The picture will be
saved to the clipboard

The picture will be
saved to the Film Roll
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Saving the picture to the clipboard

 

When you save your picture to the clipboard, you can open another application and paste 
the picture. Each time you take a picture, the previous picture on the clipboard is lost, so 
make sure you paste a picture and save it before taking another.

 

Saving the picture to a file

 

If you are saving your picture to a disk, you can save PICT, TIFF, or JPEG formats from the 
pop-up menu at the bottom of the Save dialog.

Enter a name for your picture, select a file format, and click 

 

Save

 

.

 

■

 

If you will be using the file with another Macintosh graphics program, choose PICT. 
Virtually all Macintosh applications that support graphics can read PICT files.

 

■

 

If you will be sending the file to someone who uses a PC, choose TIFF. 

 

■

 

If you will be sending the file to someone using an application that requires JPEG 
format, or if you will be using the file for a Web page, choose JPEG.

This dialog will also appear if you select a picture in the Film Roll or the Viewer and choose 

 

Save As

 

 from the 

 

File

 

 menu. See page 5-2 for more information about the Viewer, and page 
5-4 for more information about the Film Roll.

Choose a 
file formatEnter a name



 

5-4

 

Taking Pictures with QuickPICT

 

Saving the picture to the Film Roll

 

Save your pictures to the Film Roll if you want to view up to thirty-six pictures at a time. 
(QuickPICT 

 

always

 

 saves pictures to the Film Roll when you take multiple exposures. See 
page 5-11 for more information.)

When you select the Film Roll as the destination for your pictures, a thumbnail of each 
picture you take is added to the end (right side) of the Film Roll, 

 

and

 

 the picture itself is 
stored in the Film Roll folder (described on page 5-5). The first picture in the Film Roll is 
stored as a file name d 

 

Picture 1

 

; the second as 

 

Picture 2

 

; and so on. 

If the Film Roll is full (contains 36 pictures) and you click 

 

Take Picture

 

, QuickPICT will 
warn you that you must delete one or more pictures before you can add new pictures.

When you delete a thumbnail of a picture from the Film Roll, the picture is itself is deleted 
from the Film Roll folder.

The Film Roll is shown below. 

 

■

 

To show or hide the Film Roll, choose 

 

Show Film Roll

 

 or 

 

Hide Film Roll

 

 from the 

 

Window

 

 menu.

 

■

 

To move backwards and forwards through the Film Roll, use the arrows at the bottom 
left.

 

■

 

To see more or fewer pictures, click and hold the grow box at the bottom right, then 
drag it to a new size. 

 

■

 

To delete a picture from the Film Roll (and from the Film Roll folder), click the picture 
to select it and press the 

 

Delete

 

 key.

 

■

 

To delete 

 

all

 

 of the pictures in the Film Roll (and from the Film Roll folder), click the 
trash can. A dialog will appear in which you will be prompted for confirmation. (To 
disable this warning, click

 

 Don’t show me this message again

 

.) 

 

■

 

To copy a picture, select it and choose 

 

Copy

 

 from the 

 

Edit

 

 menu. You can then paste it 
into another application. 

 

■

 

To cut a picture, select it and choose 

 

Cut 

 

from the 

 

Edit

 

 menu

Use these buttons to
step backwards and
forwards through the
pictures in the roll

Click the trash can
to delete all of the
pictures in the roll

The number 
of pictures in
the Film Roll

Click and drag
to change the 
Film Roll length
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■

 

To save a picture in the Film Roll, select it by clicking, then choose  

 

Save As

 

 from the 

 

File

 

 menu. The Save dialog will appear, as described on page 5-3.

 

■

 

To view a picture in the Viewer, double-click the picture in the Film Roll. (To activate 
the Viewer, choose 

 

Show Viewer

 

 from the 

 

Window

 

 menu. See page 5-2 for more 
information about using the Viewer.)

 

Changing the location of the Film Roll files

 

QuickPICT stores the pictures in the Film Roll in a special folder named 

 

Film Roll Files

 

. By 
default, your Film Roll folder is located in the same directory as the QuickPICT 
application. To change the location of the Film Roll files, choose 

 

Film Roll Location

 

 from 
the 

 

Settings

 

 menu. Select a new location and click 

 

OK

 

. 

 

NOTE: 

 

The Film Roll can require a great deal of space. For example, if you take 36 images 
at 640 x 480 using millions of colors, the Film Roll files may take up to 36 MB.

If you wish, you can open another application and open the pictures in the Film Roll folder 
directly; QuickPICT does not need to be running. 

The file 

 

FilmRollData

 

 is used by QuickPICT to keep track of the images — do not delete 
or move this file.

 

Picture-taking options

 

QuickPICT gives you many options when taking pictures. Experiment and have fun!

 

Selecting an image area

 

If you don’t want to capture the entire image, you can select a portion of it before you take 
a picture. This saves you the time and effort of taking a picture, importing it into a graphics 
application, cropping it, and saving it again. 

 

1 .  

 

To select an area to capture, move the mouse pointer to the image window, where the 
pointer will change to a cross-hair. 

 

2 .  

 

Click and hold the mouse button as you drag the pointer to enclose the area you want 
to capture. 

 

3 .  

 

Release the mouse to show only that area in the image window. 

NOTE: The file names in the Film Roll folder may change when you 
delete one or more pictures. For example, if there are five pictures in the 
Film Roll and you delete Picture 1, Picture 2 is renamed Picture 1; Picture 
3 is renamed Picture 2; and so on. If you want to save a picture in the Film 
Roll, double-click it to display it in the Viewer, then choose Save As from 
the File menu. The Save dialog will appear, as described on page 5-3. 
(You can also cut or copy the file from the Film Roll and paste it into 
another application.)
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You can move the selected area by clicking and holding the mouse inside it. As you move 
the mouse, the selected area will show the part of the picture underneath it. 

If you want to start over, click the mouse outside the area that you selected, and the full 
image will be restored. The full image is also restored when you resize the picture, or when 
you double-click an image.

 

Changing the size of a picture

 

To change the size of the picture, choose 

 

Sizes

 

 from the 

 

Image 

 

menu. In the sizes menu, 

 

■

 

choose

 

 Full

 

 for a 640 x 480 (Color) or 320 x 240 (Grayscale) picture

 

■

 

choose 

 

Half

 

 for a 320 x 240 (Color) or 160 x 120 (Grayscale) picture

 

■

 

choose 

 

Quarter

 

 for 160 x 120 (Color) or 80 x 60 (Grayscale) picture

 

■

 

Choose

 

 Other size

 

 for any size up to a maximum of 640 x 480 (Color) or 
320 x 240 (Grayscale) 

 

■

 

You can also drag the grow icon in the lower right corner of the window. As you drag, 
a box will appear in the top center of the picture area displaying the size (in pixels) of 
the image you can take at that window size.

 

■

 

To toggle between the default window size and the previous window size, click the zoom 
box in the upper right corner of the window. For example, if you drag the window to 
show an 80 x 60 frame, clicking on the zoom box toggles between 80 x 60 and 320 x 240.

No matter which size you choose, the 

 

entire

 

 image is displayed. If you want to take a picture 
of a smaller portion of the image, see 

 

Selecting an image area

 

 on page 5-5. 

 

Changing the picture depth

 

To change the number of colors used, select 

 

Picture Depth

 

 from the 

 

Image 

 

menu. From 
the menu that appears, choose one of the following:

 

■

 

Black and White

 

 for a black and white image

 

■

 

4 Grays 

 

for a picture with 4 levels of gray

 

■

 

4 Colors

 

 for a picture with 4 colors

 

■

 

16 Grays 

 

for a picture with 16 levels of gray

 

■

 

16 Colors

 

 for a picture with 16 colors

TIP: If you are using a Color QuickCam and choose Full (640 x 480), 
and your monitor is using a resolution of 640 x 480, the image will 
occupy the entire screen, and a dialog will appear warning you that 
QuickPICT’s menus will not appear. To use the menus in this case, 
simply move the mouse to the top of the window. After a slight pause, 
the menus will appear.
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■

 

256 Grays 

 

for a picture with 256 levels of gray

 

■

 

256 Colors

 

 for a picture with 256 colors

 

■

 

Thousands

 

 for a picture with thousands of colors 

 

(Color Only)

 

■

 

Millions

 

 for a picture with millions of colors 

 

(Color Only)

NOTE: 

 

If you are using a Grayscale QuickCam, you will see all of the choices above except 
for 

 

Thousands

 

 and 

 

Millions

 

. The 

 

4 Colors

 

 and 

 

256 Colors

 

 selections will use a color 
palette, but will still create a grayscale image. 

For best quality snapshots, you will usually choose 

 

Millions

 

 (Color) or 

 

256 Grays 

 

(Grayscale).

 

Zooming the image

 

To zoom the camera, choose 

 

Angle of View

 

 from the 

 

Image 

 

menu, then choose 

 

Zoomed

 

. 
This zooms into the center of the picture, and the area on the periphery will not be 
displayed. You can also select an area and then zoom. To return to a normal picture, choose 

 

Constant

 

. 

Zooming has no effect if you are viewing a picture at a size of 640 x 480 (Color) or
320 x 240 (Grayscale).

 

Changing the shutter mode

 

QuickCam has a regular shutter, a bulb shutter which stays open until you shut it, and a 
timed-exposure shutter which stays open for a specified time period.

 

■

 

To use a bulb shutter, choose 

 

Shutter Mode 

 

from the 

 

Settings

 

 menu, then choose 

 

Bulb

 

. 
The 

 

Take Picture 

 

button will change to 

 

Open Shutter

 

. Use a bulb shutter when you 
want to take long-exposure pictures.

Click Open Shutter to open up the shutter. The button will change to Close Shutter. 

When you are done with your picture, click Close Shutter.

NOTE: If you select Bulb shutter, the Auto Capture feature will not be available, nor 
will multiple exposures.  Auto Capture is described beginning on page 5-9; multiple 
exposures are described on page 5-11.

■ To use a timed-exposure shutter, choose Shutter Mode from the Settings menu, then 
choose Timed Exposure. Enter an exposure duration in the dialog that appears.

TIP: If you are taking pictures in millions of colors, you may need to 
increase the amount of memory available to QuickPICT. Before you 
start QuickPICT, click its icon and choose Get Info from the File 
menu. Increase memory in the Preferred size box to 5000K for best 
performance. Don’t change the Minimum size!
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■ To return to a normal shutter, choose Shutter Mode from the Settings menu, then 
choose Normal.

Using the self-timer
To set the self-timer so that you can click Take Picture and still have a few seconds to select 
a great pose before the shutter opens, choose Self Timer from the Settings menu. In the 
menu that appears:

■ Choose Off to take a picture immediately after you click on Take Picture. This is the 
default setting.

■ Choose Two Seconds to have a two-second delay between the time you click Take 
Picture and the time the shutter opens. 

■ Choose Five Seconds to have a five-second delay between the time you click Take 
Picture and the time the shutter opens.

■ Choose Other to enter a different time interval.

When the self-timer is active, a timer will appear on the QuickPICT window, as shown on 
the next page.

When you click Take Picture, QuickPICT will display the number of seconds remaining 
before it takes a picture. When three seconds remain, QuickPICT will play an alert sound. 
Remember to smile!

NOTE: If you are taking multiple exposures, QuickPICT will take all of the exposures after 
the self-timer interval. See page 5-11 for more information about multiple exposures.

When the self-timer
is active, a timer will
show the number of 
seconds remaining
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Taking pictures automatically
You can use QuickPICT’s Auto-Capture feature to automatically take pictures separated by 
a specified time interval. This is especially useful for keeping an updated picture on a Web 
page. To use Auto-Capture, choose Capture Mode from the Settings menu, then choose 
Auto-Capture. 

The Auto-Capture dialog is shown below.

You can either write over the file each time you save it, or you can create a series of files 
with different names or time stamps. 

NOTE: Auto-Capture always saves the image to a file; you cannot choose another 
destination.

When Auto-Capture is active, QuickPICT will display the Auto-Capture icon, shown 
below.

NOTE: Auto-capture is not available if you have selected Bulb from the Shutter Mode 
menu or Multiple Exposure from the Settings menu. 

QuickPICT will save

Select a file format

Select a time 
interval here

Click here if you
want to save a
series of pictures

Enter a name here if
you want to save a series
and increment the file name

the latest image with
the name you enter here

Auto-Capture is active
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Auto-Capture — Saving to the same file
Use this option if you are updating a picture on your Web page.

1 .  Enter the name of the file in which to save the image in the  Save latest image as... 
field.

2 .  Choose a file format from the drop-down list (JPEG, TIFF, or PICT). If you are 
updating your Web page, choose JPEG.

3 .  Choose a value (10 Seconds, 1 Minute, 30 Minutes, or 1 Hour) from the Take Picture 
Every: drop-down list. 

4 .  For more options, choose Other from the drop-down list. This brings up the Auto-
Capture Options dialog, shown on page 5-10.

5 .  Click OK.

6 .  The Take Picture button will change to Begin Capture. When you click it, the 
auto-capture will begin. Begin Capture will change to End Capture. 

7 .  To stop Auto-Capture, click End Capture.

Auto-Capture — Saving a file series
1 .  To save a file series, click the Create File Series checkbox.

2 .  Choose a file format from the drop-down list (JPEG, TIFF, or PICT).

3 .  To use the time of capture as the file name (measured in Greenwich Mean Time), 
choose Use GMT time stamp. The name of each file will then be the time at which it 
was created. For example, if you take a picture on March 13, 1996 at 14:39:42 GMT, 
the file name will be 130396143942 (seconds will not appear if the interval is greater 
than one minute).

4 .  To save a series and increment the file name, choose Increment file name. Enter a 
name in the box. When QuickPICT takes the series, it will number the picture using 
the file name you enter. For example, if you choose mypicture, QuickPICT will begin 
with mypicture 1, followed by mypicture 2, and so on.

NOTE: A copy of the latest picture taken will also be saved with the name entered in 
the Save latest image as field.

Auto-Capture — Advanced options
If you want more control over when your pictures will be taken, choose Other from the 
Take Picture Every drop-down list in the Auto-Capture dialog. This brings up the 
Auto-Capture Options dialog, shown on the next page. You can use this dialog to control 
the days and dates on which pictures are taken, as well as the time of day during which 
Auto-Capture will be active.
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1 .  Enter a value in the Take picture every box, and choose Seconds, Minutes, or Hours 
from the drop-down list.

2 .  If you want Auto-Capture to continue for more than one day, you can choose the days 
of the week on which it will be active by clicking the checkbox next to each day. 

3 .  To restrict Auto-Capture to certain times of day, use the Active between settings. To 
change a value, click on it and use the arrows to adjust the value. For example, if you 
want pictures to be taken only at night, begin at 8p.m. and end at 6 a.m.

4 .  To restrict the calendar days on which Auto-Capture is active, use the Effective From 
settings. To change a value, click on it and use the arrows to adjust the value.

5 .  If you want a warning sound to play before each picture is taken, click the Play 
warning sound before capture checkbox.

Taking multiple exposures
To take multiple sequential exposures, choose Multiple Exposure from the Settings menu. 
The pictures will appear on the Film Roll, described beginning on page 5-4.

■ Choose Two or Five from the Multiple Exposure menu to take two or five images when 
you click Take Picture. The new pictures will be added to the end of the Film Roll.

■ Choose Other... from the Multiple Exposure menu to take another number of pictures, 
up to a maximum of thirty-six. The new pictures will be added to the end of the Film 
Roll. 

The Film Roll can hold thirty-six images. If the number of exposures you choose is higher 
than the remaining space on the Film Roll, QuickPICT will fill the Film Roll and then warn 
you that the Film Roll is full and stop taking pictures. For example, if there are two open 
spaces on the Film Roll and you select Five from the Multiple Exposure menu, QuickPICT 

Enter a value and select
Seconds, Minutes, or Hours

Choose
capture days

Choose time
of day 

Choose dates

Click here to
take pictures
all day
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will only add two pictures to the Film Roll. If you want to add more pictures to the Film 
Roll, you must delete one or more pictures. QuickPICT will also warn you when your disk 
becomes full. See page 5-4 for information about working with the Film Roll. 

NOTE: If you are taking more than one exposure, you will not be able to switch 
destinations; the pictures will automatically be added to the Film Roll. To switch 
destinations, choose One from the Multiple Exposure menu. You can then choose any of 
the available destinations.

Switching between cameras
You can connect both Grayscale and Color QuickCams to your Macintosh at the same 
time, as long as both the Printer and Modem serial ports are free, or you have an A/B switch 
box installed. 

■ To switch to the Grayscale QuickCam, choose Connectix QuickCam from the Image 
menu and select the serial port to which it is connected.

■ To switch to the Color QuickCam, choose Connectix Color QuickCam from the Image 
menu and select the serial port to which it is connected.

You do not need to exit QuickPICT or QuickMovie to switch between cameras.
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6

 

RECORDING MOVIES 
WITH QUICKMOVIE

 

About QuickMovie

 

You can use QuickMovie to capture, edit, and save video, including time-lapse and 
stop-action animation. 

 

Starting QuickMovie

 

1 .  

 

To start QuickMovie double-click its icon. 

 

2 .  

 

QuickMovie will start in 

 

Record

 

 mode. Enter a name for your new movie.

 

3 .  

 

Choose a location in which to save it, 

 

4 .  

 

Click 

 

OK

 

. 

 

5 .  

 

You are ready to record. See page 6-5 for information on recording a video.

 

Switching between Record and Edit modes

 

When you start QuickMovie by double-clicking its icon, it starts in 

 

Record

 

 mode, which 
you use to capture new video. QuickMovie also has an 

 

Edit

 

 mode, which you use to view 
and edit video.

 

■

 

When QuickMovie is in Record mode, the button at the bottom left of its window will 
look like this: 

 

■

 

When QuickMovie is in Edit mode, the button at the bottom left will look like this:

To toggle from one mode to the other, click the button. 
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QuickMovie’s Controls

 

QuickMovie has different sets of controls for editing (when in Edit mode) and recording 
(when in Record mode). Both sets of controls are described below.

 

Controls for recording

 

The Record window is shown below. 

 

■

 

Record Button

 

. Click this button to start recording. While recording, the button 
changes to 

 

Stop

 

. Click it again to stop recording.

 

■

 

Brightness Slide

 

r. This adjusts the amount of time the CCD sensor array is active for 
each frame. 

 

Notes about setting brightness

 

For best results, it is very important to have enough light. See Chapter 4 for tips on setting 
the brightness so that you get the best possible image. 

 

Controls for editing

 

In Edit mode, QuickMovie uses the standard QuickTime Play Bar and Slider. The Edit 
window is shown on the next page.

This icon means
QuickMovie is in
Record mode Drag this slider

to adjust brightness

Click here
to record

Click at either end
of the slider to 
adjust brightness
in small steps
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■

 

Volume Control.

 

 Clicking on the speaker icon pops up a slider that allows you to set the 
current sound playback level (the record levels are set by choosing Other on the Audio 
Settings menu when in Record mode).

 

■

 

Slider

 

. The 

 

thumb

 

 on the slider indicates the current position in the movie. Drag the 
thumb to move backwards or forwards in the movie. To select a section of the movie, 
hold down the Shift key while dragging the thumb.

 

■

 

Play button.

 

The Play button plays the movie in the display window starting from the 
current thumb position. While the movie is playing the play icon changes into a pause 
icon, which allows you to temporarily halt playback of the movie. 

 

■

 

Backwards step button.

 

 Steps you backwards through the movie (moves the thumb to 
the left). 

 

■

 

Forward step button.

 

 Steps you forward through the movie (moves the thumb to the 
right).

This icon means
QuickMovie is in
Edit mode

Click here to 
adjust volume

Click here to play

The thumb shows
the progress of the
movie as it plays

Use these buttons
to step backwards
and forwards
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Audio-recording options

 

Choosing a microphone

 

Use the 

 

Audio

 

 menu to select an audio source. If you have more than one microphone 
attached to your Mac, you can switch between them in the 

 

Audio

 

 menu.

 

Choosing a sampling rate

 

There will also be choices to determine the audio sampling rate, which may be different for 
different audio sources. Typical choices are:

 

■

 

44kHz

 

 — Choose this for the best audio sampling rate, about equivalent to what you 
get with most VCRs.

 

■

 

22kHz 

 

—This is about equivalent to an excellent AM radio.

 

■

 

11kHz 

 

—This is telephone quality. 

To bring up the standard Macintosh Sound dialog, choose 

 

Audio other

 

. Use the Sound 
dialog (shown below) to make all of the above changes in addition to choosing audio 
compression. 

Select 

 

Source

 

 to choose an audio source, 

 

Sample

 

 to choose a sampling rate, or 

 

Compression

 

 to choose audio compression. 

 

Turning off audio recording

 

To turn off audio recording, choose 

 

No Audio

 

 from the 

 

Audio

 

 menu.

NOTE: The Grayscale QuickCam has an internal microphone. If you are 
using a Color QuickCam and want to record sound with your movie, you 
will need an external microphone. If you do not have a microphone, you 
can still record movies, but they will not have audio. 
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Video-recording options

 

You can change the video settings only when QuickMovie is in Record mode. Use the 

 

Video

 

 menu to record a normal, time-lapse, or stop-action movie. You can also choose to 
turn off video recording.

 

Normal recording

 

To record a normal movie, choose 

 

Video

 

 from the 

 

Settings

 

 menu, then choose 

 

Normal

 

. 
This is the default setting.

 

Stop-action recording

 

To record a stop-action movie, choose 

 

Video

 

 from the 

 

Settings

 

 menu, then choose 

 

One 
Frame at a Time

 

. Each time you click 

 

Record

 

, QuickMovie will capture a single frame.

 

Time-lapse recording

 

To take time-lapse movies, choose 

 

Video

 

 from the 

 

Settings

 

 menu, then choose 

 

Time-lapse

 

. 
In the dialog that appears, enter a time interval in seconds, minutes, or hours. When you 
click 

 

Record

 

, QuickMovie will capture frames separated by the time interval you chose. To 
stop recording, click 

 

Stop

 

.

 

Turning off video recording

 

To turn off video  recording, choose 

 

Video

 

 from the 

 

Settings

 

 menu, then choose 

 

No Video

 

. 
If audio recording is enabled, you can record sound when you click 

 

Record

 

. The words 

 

No 
Video

 

 will appear in the QuickMovie window.

 

Recording a movie

 

1 .  

 

To record a movie, make sure QuickMovie is in Record mode (the button at the lower 
left is a camera. If it is not, click the button once).

 

2 .  

 

Make sure your QuickCam is pointing at what you want to record. 

 

3 .  

 

Adjust the brightness control until you get the best looking picture (if you have not 
chosen Auto Brightness - see page 4-3 for more information).

 

4 .  

 

Adjust the color to suit the lighting and background (see Chapter 4). 

 

5 .  

 

If you want to set a specific frame rate or change the compression scheme used, 
choose 

 

Camera Settings

 

 from the 

 

Video 

 

menu, then choose 

 

Video Other

 

. The dialog 
that appears is shown on page 6-10.

 

6 .  

 

Drag the window to the size of the movie you want. Larger frames will record fewer 
frames per second, producing less fluid-looking video.

 

7 .  

 

Click the 

 

Record

 

 button. Once recording has begun, the 

 

Record

 

 button changes to a 

 

Stop

 

 button. To pause or stop the recording, click the 

 

Stop

 

 button. 
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Viewing a movie

 

To review your movie, switch to Edit mode by clicking the QuickCam button at the lower 
left corner. Use the QuickTime Play Bar (described beginning on page page 6-2) to play 
your movie.

 

Saving a movie

 

To save your movie, select 

 

Save

 

 from the 

 

File

 

 menu. When you save a movie, QuickMovie 
uses the video compression the digitizer used when recording the movie. If you want to 
save the movie so that other people can view it, you must use the 

 

Compress Movie

 

 item 
from the 

 

File

 

 menu. For more information about compressing and saving movies, see page 
6-11.

 

Opening a movie you have saved

 

To open and edit a movie you have previously saved, close the active movie, then select 

 

Open

 

 from the 

 

File

 

 menu. Use the dialog that appears to find the movie you wish to open. 
You can also double-click the icon of any movie you have previously saved using 
QuickMovie. Once you have opened the movie, you can edit or add to it and save it again.

 

Editing a movie

 

You can add video to the end of an existing movie, or insert new video in the middle of the 
movie. You can also delete, cut, copy, or paste sections of video. You must first switch to 
Edit mode to edit a video. If you open an existing movie file, QuickMovie automatically 
starts in Edit mode.

 

Adding video into a movie

 

You can append or insert video to a movie you have just recorded, or to one you recorded 
previously and saved. 

 

1 .  

 

To add a new scene to a movie you have just recorded, or which you have opened, 
make sure QuickMovie is in Edit mode.

 

2 .  

 

Move the thumb on the slider to where you want to start recording the new scene (the 
standard QuickTime play bar and slider is described beginning on page 5-2). To 
append to the end of an existing movie, the thumb should be at the far right.

 

3 .  

 

Click the icon at the lower left to change to Record mode. 

 

4 .  

 

Adjust the image to suit the lighting and background (see Chapter 4 for more 
information).

IMPORTANT NOTE: If you are using a Color QuickCam and used VIDEC 
compression while recording, other people without a Color QuickCam will not be 
able to view the movie unless you use the Compress Movie option or give them a 
copy of the VIDEC decompressor. See page 6-10 for more information.
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5 .  

 

Click the 

 

Record

 

 button. Once recording has begun, the 

 

Record

 

 button changes to a 

 

Stop

 

 button. 

 

6 .  

 

To pause or stop the recording, click the 

 

Stop

 

 button. 

 

7 .  

 

To review your movie, click the icon in the lower left corner to Edit mode. Press the 

 

Play

 

 button or move the Slider thumb manually through the movie.

 

Selecting a section of video

 

If you want to replace, move, or delete a section of video, you must first 

 

select

 

 it. To select 
a section, hold down the Shift key while dragging the slider. The selected area will be 
highlighted in the Play bar. 

 

Replacing video in an existing movie

 

Once you have captured a movie, you can replace any section of video.

 

1 .  

 

Make sure QuickMovie is in Edit mode.

2 .  Select the area you wish to replace.

3 .  To replace the selected section with new video, switch to Record mode by clicking the 
icon at the lower left. 

4 .  Adjust the image to suit the lighting and background (see Chapter 4 for more 
information).

5 .  Click the Record button. Once recording has begun, the Record button changes to a 
Stop button. 

6 .  To pause or stop the recording, click the Stop button. 

7 .  To review your movie, click the icon in the lower left corner to switch to Edit mode. 
Click the Play button or move the Slider thumb manually through the movie.

Deleting part of an existing movie
You can delete portions of an existing movie. If you like, you can also replace the deleted 
portions with new video. 

1 .  Make sure QuickMovie is in Edit mode.

2 .  Select the area you wish to delete.

3 .  Press the Delete key to delete the selection, press Command-X to cut the section and 
copy it to the clipboard, or choose Cut from the File menu. 

4 .  To review your movie, click the icon in the lower left corner to switch to Edit mode. 
Press the Play button or move the Slider thumb manually through the movie.

5 .  Save your new movie.
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Duplicating a section within a movie
Sometimes a section is so good, you want to see it twice!

1 .  Make sure QuickMovie is in Edit mode.

2 .  Select the area you wish to duplicate.

3 .  Press Command-C or choose Copy from the Edit menu. 

4 .  Move the slider to the position where you want to place the scene.

5 .  Press Command-V or choose Paste from the Edit menu.

6 .  To review your movie, click the icon in the lower left corner to switch Edit mode. 
Press the Play button or move the Slider thumb manually through the movie.

7 .  Save your new movie.

Moving a section within a movie
If you don’t like the sequence of sections in your movie, you can rearrange them to your 
heart’s content. 

1 .  Make sure QuickMovie is in Edit mode.

2 .  Select the area you wish to move.

3 .  Press Command-X or choose Cut from the Edit menu. 

4 .  Move the slider to the position where you want to place the scene.

5 .  Press Command-V or choose Paste from the Edit menu.

6 .  To review your movie, click the icon in the lower left corner to switch to Edit mode. 
Press the Play button or move the Slider thumb manually through the movie.

7 .  Save your new movie.

Copying video from one movie to another 
QuickMovie currently only allows you to have one movie open at a time, so you will have 
to open the source movie, cut or copy a section, close the first movie, open the destination 
movie, and paste the new section.

1 .  Open the movie that will be the source.

2 .  Make sure QuickMovie is in Edit mode.

3 .  Select the area you wish to move.

4 .  Press Command-C or choose Copy from the Edit menu. 

5 .  Close the source movie by choosing Close from the File menu. 

6 .  Open the movie into which the video will be pasted.

7 .  Move the slider to the point where you want to insert the video.

8 .  Press Command-V or choose Paste from the Edit menu. 
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9 .  To review your movie, click the icon in the lower left corner to switch to Edit mode. 
Press the Play button or move the Slider thumb manually through the movie.

10 .  Save your new movie.

A note about display size
The window resizing control allows you to change the image size of the QuickMovie you’re 
recording. As you drag this control a small window pops up at the top of the record 
window showing you the window size; this size changes as you drag so that you can create 
a record window of exactly the size you need.

Interesting things can happen when you attempt to record a window of one size into an 
existing movie of a different size. For example, if you had a movie that was 320 x 240 pixels 
and recorded new video at 160 x 120, you would have two choices at the end of the 
recording session: 

1 .  QuickMovie can scale the smaller window up to the larger window size, which may 
result in “fat pixels,” but provides you with a movie that always has the same size 
window, and that window is always filled, or 

2 .  QuickMovie will place the smaller size recording into the larger size window, leaving 
white space around the right and bottom edges. 

QuickMovie will always ask you which method you want it to use when you record movie 
clips with different window sizes or aspect ratios.

About frame rates
See How to get the best frame rate in QuickMovie on page 4-7 for detailed instructions 
on how to maximize the frame rate.

About video compression
Video compression comes into play when you record a new video and when you flatten 
and compress a video so that other people can view it.

Compressing a video while recording 
When you record video, QuickMovie compresses the image. QuickTime movies are 
 always  compressed in some format as they arrive from a digitizer such as a Connectix 
QuickCam. In fact, when you choose None in the Compression dialog, QuickTime still 
compresses the movie, albeit not as much as when you choose other compression options. 

When you choose a digitizer, QuickMovie will automatically select the optimal 
compression setting for recording. In the case of the Color QuickCam, this is VIDEC. (If 
you choose another compression option, the size of the movie file may increase.) The video 
data is then written directly to disk using this setting (that is why you choose a file name 
before you start recording). If you change the compression setting, you may not get the 
best frame rate when you record a movie. If you will not be sending the video to another 
person, simply choose Save from the File menu to save your movie without any further 
compression. 
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If you do need to change the compression that QuickMovie will use during recording, 
choose Camera Settings from the Settings menu, then choose Video other. In the Video 
Other dialog, choose Compression from the pop-up menu. The Compression dialog is 
shown below.

Use the Compressor: pop-up menu to choose a compressor.

Compressing a color movie so that other people can view it
If you record a color movie using VIDEC (the default), and you want to send it to another 
person, they will not be able to view the movie if they do not have the Color QuickCam 
software installed. In that case, you should do one of two things;

■ Give them the installable VIDEC decompressor, available from Connectix.

■ Save the movie using a different compression scheme. To use a different compression 
scheme, choose Compress Movie from the File menu (described on page 6-11). The 
Compress Movie option will both compress and flatten your movie. Flattening is 
important if you have edited the movie, and is described below.

About flattening QuickTime movies
Flattening a movie makes sure that the movie is self-contained, and removes references to 
external resources. If you don’t flatten the movie, it cannot be viewed on any other 
machine, for example on another Mac, or on a Windows or UNIX system.

Why is flattening necessary? When you edit a QuickTime movie, for example by moving 
or deleting a section, the movie is not physically changed. Instead, all QuickTime 
applications store special aliases that allow them to locate the original information without 
actually moving or deleting it. For example, if you cut a section from one movie and paste 
it into another, only a reference to the data is transferred, not the data itself. This is a handy 
feature that allows you to create and edit movies without using up all of your disk space.
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However if you transfer the movie to another system, the alias information is moved, but 
the original data is not. As a result, QuickTime may not be able to find the original video 
data, and you will not be able to play the movie. Flattening a movie makes sure that all of 
the original data is stored in the file, so that you can freely transfer and play it on any other 
system.

The Compress Movie menu item always produces a flattened movie, in addition to 
compressing the audio and video.

Using Compress Movie to create a compressed and flattened 
movie
Choose Compress Movie from the File menu to compress video and to flatten the movie 
so that it can be viewed on other systems. 

1 .  When you choose Compress Movie, a dialog will appear asking if you want to save 
any changes to the original movie (the original will be saved but not flattened). Click 
Save to continue.

2 .  In the next dialog, enter the name of the new compressed and flattened movie, and 
click New. This dialog is shown below.

3 .  Next, the Video compression dialog will appear, as shown below.
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4 .  Choose a compression option. If you are using a Color QuickCam and do not use 
VIDEC, or you are using a Grayscale QuickCam, we recommend either Cinepak, 
Motion JPEG, or Video. Cinepak offers the option of using 256 or millions of colors, 
while Video offers only thousands of colors. Keep in mind that the more colors you 
choose, the larger the resulting video file. 

5 .  You can also choose how often key (reference) frames are saved. The fewer key frames 
you save, the smaller the movie. However, the more key frames you save, the better 
the quality of the movie. A good rule of thumb is to omit key frames, or to provide 
one key frame per second.

6 .  Click OK to compress, flatten, and save your file.

NOTE: The VIDEC item in this dialog is for recording with a Color QuickCam 
only; you cannot choose it for compressing and flattening.
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USING THE 
QUICKSAVER 
UTILITY

 

QuickSaver is a screen saver module that works with After Dark

 

TM

 

 and After Dark 
compatible applications such as DarkSide. DarkSide is a freeware application written by 
Tom Dowdy and is available in the Connectix forum of the following commercial online 
services:  

 

■

 

Internet: www.connectix.com

 

■

 

America Online:  Keyword: Connectix

 

■

 

CompuServe:  Go Connectix 

To use QuickSaver if you currently have After Dark loaded on your machine:

 

1 .   

 

Choose 

 

Control Panels

 

 from the Apple menu.

 

2 .

 

Open After Dark. 

 

3 .

 

Select 

 

QuickSaver

 

 to display the image from your QuickCam and periodically move 
it around the screen. 

– Use the slider at the top to choose how often to move the image.

– Click Fade between moves to dissolve the image before moving it.

– To preview QuickSaver, click 

 

Demo

 

. Click 

 

Stop

 

 to end the demo.

– When you are finished, close After Dark.

 

4 .

 

Select 

 

Full-Screen QuickSaver

 

 to display the QuickCam image on the entire screen.

– To preview the full-screen QuickSaver, click 

 

Demo

 

. Click 

 

Stop

 

 to end the demo.

– When you are finished, close After Dark.

 

 

This document was created with FrameMaker 4.0.4



 

7-2

 

Using the QuickSaver Utility



 

APPENDICES

 

 

This document was created with FrameMaker 4.0.4



 

Camera Specifications

 

A-1

 

A

 

CAMERA 
SPECIFICATIONS

 

Grayscale QuickCam

 

Grayscale QuickCam’s specifications:

 

■  

 

Up to 320 x 240 pixel recording.

 

■  

 

4-bit gray scale (16 shades of gray).

 

■  

 

Sound recorded at 5Khz sampling when using QuickCam’s internal microphone.

 

■  

 

Frame rates of up to 15 fps (varies by window size being recorded and the 
Macintosh model).

 

■  

 

Powered from serial port of computer, draws less than 200 milliwatts of current.

 

■  

 

Field of view is approximately 65

 

°

 

 (equivalent to a 38mm lens on a 35mm camera).

 

■  

 

Focus is fixed from 18 inches to infinity.

 

■  

 

Maximum lens speed is f/1.9.

 

Color QuickCam

 

Color QuickCam’s specifications:

 

■  

 

Up to 640 x 480 pixels recording at 24-bit color.

 

■  

 

Frame rates of up to 30 fps (varies by window size being recorded and the 
Macintosh model).

 

■  

 

Powered from ADB port of computer, draws less than 2 watts of power.

 

■  

 

Field of view is approximately 48

 

°

 

 (equivalent to a 50mm lens on a 35mm camera).

 

■  

 

Focus is adjustable from 1 inch to infinity.

 

■  

 

Maximum lens speed is f/1.6.
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IMPORTANT 
INFORMATION 
ABOUT THE APPLE 
DESKTOP BUS 
(ADB)

 

What is the Apple Desktop Bus?

 

The Apple Desktop Bus, or ADB, is a standard for input devices connecting to the Apple 
IIGS and later Macintosh computers. The ADB also supplies power to each device attached 
to it.

The Apple Desktop Bus is an intelligent connection, so you can have many devices of 
different types connected in a chain. Normally you will connect your keyboard and mouse 
to the ADB, but you can also install devices such as joysticks or trackballs. Apple does not 
recommend connecting more than 3 ADB devices at any time. 

 

How do I connect devices to the ADB?

 

1.   

 

To safely connect or disconnect ADB devices, make sure the power to your 
Macintosh is off. (If you have a PowerBook, place it into sleep mode — see 

 

PowerBooks, Sleep Mode, and the ADB 

 

on the next page.)

WARNING: You will need to plug your QuickCam into your 
Macintosh’s ADB port. You should NEVER change any connection to 
the ADB port unless the power to your Macintosh is switched OFF, 
otherwise you may damage your computer’s logic board. 
DO NOT unplug your mouse or keyboard from the ADB port until 
you have switched the power off.
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Important Information About The Apple Desktop Bus (ADB)

 

2 .   

 

Insert or remove devices from the ADB chain. The mouse is always the last device in 
the chain, as it has only a single connection. Other devices may be placed anywhere 
between the mouse and the computer.

 

3 .   

 

Turn the power back on (or bring your PowerBook out of Sleep Mode). 

 

PowerBooks, Sleep Mode, and the ADB

 

When a PowerBook is in 

 

Sleep Mode

 

, all ADB devices are automatically disabled. This 
prevents them from drawing power from the PowerBook and draining the battery. This 
also means that an external ADB device cannot be used to wake up your PowerBook.

To safely connect your Connectix QuickCam to your PowerBook, simply put your 
PowerBook in Sleep Mode by closing the cover, connect the ADB cable, then re-open the 
cover to resume working. 

In general, you can make changes to any cable connection while your PowerBook is in 
sleep mode. This includes serial and SCSI devices, although you will have to re-start your 
PowerBook before it will correctly recognize SCSI devices connected in this manner.

 

How long can the ADB cable be?

 

Apple recommends a 

 

maximum

 

 cable length of 5 meters (the total length of the cable 
connecting all devices to the ADB). 

 

How does Connectix QuickCam use the ADB?

 

Your Connectix QuickCam draws its power from the ADB (make sure that your Macintosh 
is off before connecting it). The video signal from your Connectix QuickCam is sent to one 
of your Macintosh’s serial ports.
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FREQUENTLY 
ASKED 
QUESTIONS

 

Q

 

How does QuickCam work?

 

A

 

QuickCam uses a CCD (Charge Coupled Device imager) to capture the image from the 
lens. The image is accumulated and then transmitted through a serial port to the 
computer, where a Connectix-written ‘vdig’ (software video digitizer) for QuickTime 
converts the bits into an image.

 

Q

 

Can I use my QuickCam and my modem on the same serial port? 

 

A

 

No, if you have a Grayscale QuickCam. If you have a Color QuickCam, you can use 
version 3.4 or later of Port Juggler by Momentum. Otherwise you have two hardware 
options:

 

■  

 

Unplug the modem and plug in the QuickCam when needed

 

■  

 

Purchase an approved A/B serial port switch-box from Connectix or a computer 
reseller. There are many brands, but make sure that your A/B switch-box switches all 8 
pins simultaneously, and the cable must be ‘pass-through’ rather than ‘modem’ cabling 
(modem cables switch pins 1 & 2 with pins 7 & 8).

 

Q

 

Does my QuickCam use the ADB port? 

 

A

 

The Grayscale QuickCam does not; the Color QuickCam draws its power from the 
ADB port. You can plug other ADB devices, such as your keyboard and mouse, into 
the ADB connector on Color QuickCam. For more information about the Apple 
Desktop Bus (ADB), see Appendix B.

 

Q

 

Will the ADB connector on my Color QuickCam affect my other ADB devices? 

 

A

 

 No, the ADB connector on the Color QuickCam should not affect other devices.

 

Q

 

Does my QuickCam work with the built-in digitizer, or can I use a third-party card? 

 

A

 

Both the Color and Grayscale QuickCams are themselves digital devices and do not 
need a built-in digitizer or a third-party digitizer card. 

 

Q

 

Is there a limit to how long QuickCam can be extended from the CPU? 

 

A

 

 Yes. Color QuickCam can be extended up to 18 ft from the CPU with extension cables 
available from Connectix or computer stores.

 

Q

 

Will Connectix QuickCam work with serial ports from a NuBus card? 

 

A

 

 No, Connectix QuickCam will only work if it is plugged into a serial port on the 
Macintosh motherboard. If you have a Color QuickCam, you can also use a Port 
Juggler.
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Frequently Asked Questions

 

Q

 

Do I need a microphone to record sound?

 

A

 

The Grayscale QuickCam has a built-in microphone; the Color QuickCam requires an 
external microphone.

 

Q

 

How much file space do I need for a still PICT file? 

 

A

 

 The actual file size for your PICT will vary with the color depth, file format, and image 
size. Here are some approximate values for the Color QuickCam:

Here are some approximate values for the Grayscale QuickCam:

 

Q

 

 How much file space do I need for a 10-second video?

 

A

 

The actual file size for a 10-second video will vary with the color depth, file format, and 
image size. It will also depend on the frame rate, compression type, addition of audio, 
and CPU speed 

 

■  

 

Here are some approximate values for the Grayscale QuickCam at 320 x 240:

– Each 10 seconds of video with audio (256 grays, compressed) ~ 750 KB - 1.5 MB

 

Image Size
(in pixels)

Format Colors File Size (KB)

 

640 x 480 JPEG Millions 450 KB

640 x 480 PICT Millions 750 KB

320 x 240 JPEG Millions 140 KB

320 x 240 PICT Millions 190 KB

640 x 480 JPEG Thousands 440 KB

640 x 480 PICT Thousands 440 KB

320 x 240 JPEG Thousands 150 KB

320 x 240 PICT Thousands 130 KB

 

Image Size
(in pixels)

Format Grays File Size (KB)

 

320 x 240 JPEG 256 60 KB

320 x 240 PICT 256 60 KB

320 x 240 JPEG 16 60 KB

320 x 240 PICT 16 34 KB

160 x 120 JPEG 256 17 KB

160 x 120 PICT 256 17 KB

160 x 120 JPEG 16 17 KB

160 x 120 PICT 16 17 KB
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– Each 10 seconds of video with audio (256 grays, uncompressed) ~ 1.7 MB - 2.5 MB

 

■  

 

Here are some approximate values for the Color QuickCam at 640 x 480:

– Each 10 seconds of video with audio (thousands of colors, VIDEC) ~ 2-5 MB 

– Each 10 seconds of video with audio (uncompressed) ~ 10 MB at 640x 480

 

Q

 

Can Connectix QuickCam take close-ups?

 

A

 

The Grayscale QuickCam has a fixed focus from eighteen inches to infinity; the Color 
QuickCam uses a manually adjustable lens that can be focused from one inch to 
infinity.  

 

Q

 

Is there a version of QuickCam for PCs?

 

A

 

 Yes. Connectix offers both Color and Grayscale QuickCams for Windows-based PCs. 
To find out more about QuickCam for Windows, check our Web page at 
http://www.connectix.com, or contact us at the addresses listed in Appendix D.

 

Q

 

Can the Macintosh QuickCam be used with a PC?

 

A

 

 No. Because of different system architectures, QuickCams for Macintoshes and PCs 
are completely different cameras and are not interchangeable. 

 

Q

 

Does Connectix QuickCam work on non-US machines? 

 

A

 

 Yes, because Connectix QuickCam uses direct-to-digital video instead of NTSC or 
PAL, it will work on all QuickTime-compatible Macintoshes. The Color QuickCam 
draws its power from the ADB port of the computer; you do not need special power 
adapters. 

 

Q

 

Can the CCD get an image burned in by pointing it at the same subject for a long time? 

 

A

 

 No. 

 

Q

 

 If a QuickCam is pointed at the computer screen, will the feedback damage the QuickCam? 

 

A

 

 No. 

 

Q

 

Why does my hard drive spin down when I use my QuickCam on a PowerBook? 

 

A

 

 Apple designed PowerBooks so that the hard drive automatically spins down 
whenever the built-in microphone is activated. This prevents the noise from the hard 
drive from being recorded. You should use a microphone plugged into the 
microphone jack, not the built-in microphone.  

 

Q

 

 My PowerBook 5xx does not display a picture, or freezes. What is happening? 

 

A

 

 Check the version of your Connectix QuickCam software. You should have version 
1.0.3 or higher. To determine the version you have, select the QuickPICT application 
and then choose 

 

Get Info

 

 from the 

 

File

 

 men. If you have an older version, updater 
software is available FREE online at the locations listed in Appendix D.

 

Q

 

 Is there any compression going on inside the camera?  What is VIDEC?

 

A

 

 The Connectix Color QuickCam uses a built-in compression technology called 
VIDEC (Video Digitally Enhanced Compression).  This technology was developed by 
Connectix  specifically for Color QuickCam.VIDEC (patent pending) yields faster 
frame rates, allows transmission of color digital data over a standard serial port 
without custom hardware, and produces smaller files on your hard disk.
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Q

 

Does Connectix QuickCam require QuickTime? 

 

A

 

 Yes. Connectix includes QuickTime on the installation disks  that come with every 
QuickCam.

 

Q

 

Can a Connectix QuickCam be used for videoconferencing? 

 

A

 

 Yes! Connectix QuickCam is a video input device that can be used with 
videoconferencing software. Connectix also offers VideoPhone, a complete, 
inexpensive videoconferencing solution that can be purchased from most computer 
mail-order houses.  You can also buy a QuickCam and VideoPhone bundled together. 
Connectix QuickCam is also compatible with CU-SeeMe from White Pine Software, 
however Connectix does not offer support for CU-SeeMe. 

 

Q

 

Why do I see menu items for colors in the Grayscale QuickCam picture depth menu?

 

A

 

Because the Grayscale QuickCam can generate an image using the grayscale values 
from a color palette. 

 

Q

 

How many frames per second (fps) can QuickCam capture? 

 

A

 

 The frame rates achieved by Connectix Color QuickCam depend upon several factors, 
including the type and speed of CPU, lighting levels, and the level of compression and 
sharpness being used. 

 

■  

 

The following table illustrate some sample frame rates for a Grayscale QuickCam at an 
image size of 160 x 120 pixels on a low-end PowerMac (values for Thousands of colors 
use a color palette, but are a grayscale image):

 

Mode Frames/second 
(fps)

 

Thousands of colors*, high sharpness, Video compression 8 fps

Thousands of colors*, medium sharpness, Video compression 16 fps

Thousands of colors*, low sharpness, Video compression 18 fps

256 grays, high sharpness, no compression 8 fps

256 grays, medium sharpness, no compression 14 fps

256 grays, low sharpness, no compression 16 fps

16 grays, high sharpness, no compression 10 fps

16 grays, medium sharpness, no compression 26 fps

16 grays, low sharpness, no compression 28 fps
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■  

 

The following table illustrate the effect of compression on frame rates for a Grayscale 
QuickCam for an image size of 320 x 240 pixels on a low-end PowerMac (values for 
Thousands of colors use a color palette, but are a grayscale image):

 

■  

 

The following table illustrate some sample frame rates for a Color QuickCam at an 
image size of 160 x 120 pixels on a low-end PowerMac:

 

■  

 

The following table illustrate the effect of compression on frame rates for a Color 
QuickCam for an image size of 320 x 240 pixels on a low-end PowerMac:

Keep in mind that these are sample 

 

capture

 

 rates. The rate at which movies can be 
recorded will be somewhat slower due to the overhead of writing to your disk drive.

 

Mode Frames/second 
(fps)

 

Thousands of colors*, high sharpness, Video compression 2 fps

Thousands of colors*, medium sharpness, Video compression 6 fps

Thousands of colors*, low sharpness, Video compression 8 fps

256 grays, high sharpness, no compression 2 fps

256 grays, medium sharpness, no compression 4 fps

256 grays, low sharpness, no compression 6 fps

16 grays, high sharpness, no compression 3 fps

16 grays, medium sharpness, no compression 10 fps

16 grays, low sharpness, no compression 20 fps

 

Mode Frames/second 
(fps)

 

Millions of colors (uncompressed) 4 fps

Thousands of colors (high sharpness) 8 fps

Thousands of colors (medium sharpness) 15 fps

Thousands of colors (low sharpness) 30 fps

 

Mode Frames/second 
(fps)

 

Millions of colors (uncompressed) 1 fps

Thousands of colors (high sharpness) 4 fps

Thousands of colors (medium sharpness) 6 fps

Thousands of colors (low sharpness) 9 fps
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Frequently Asked Questions

 

Q

 

My playback speed doesn’t seem to match your listed specifications. What’s going on?

 

A

 

 Bottlenecks to recording speed include the speed of the serial port, the speed of your 
hard disk, how much RAM you have, and the speed of your processor. The frame rates 
given in the specifications are the raw feed from the camera displayed live on screen

 

Q

 

With which other applications is Connectix QuickCam compatible? 

 

A

 

 Any application that supports QuickTime is compatible with QuickCam. PICT, TIFF 
or JPEG files captured with QuickCam’s QuickPICT software can be used with any 
application that supports these file formats. QuickMovie saves movies in standard 
QuickTime format.

 

Q

 

Are there plug-ins for Adobe Photoshop and/or Premiere that will capture images and movies 
directly into those applications?

 

A

 

 Yes. Most online services should have a third-party plug-in for Adobe Photoshop, 
however this has not yet been tested with Connectix Color QuickCam. Adobe 
Premiere does not require plug-ins, since it is already QuickTime-compatible and can 
capture video directly from QuickCam.

 

Q

 

How can I obtain the latest software updates from Connectix? 

 

A

 

 Connectix maintains a number of on-line venues for easy, 24-hour access to the latest 
Connectix software updates. Updates can be downloaded from any of the online sites 
listed in Appendix E. If you do not have online access, call our toll-free number (1-
800-950-5858) and ask for the Update Department from 8 a.m. to 5 p.m. Pacific Time, 
Monday through Friday. Please have your credit card and QuickCam registration 
number ready. The update is free, however there is a $9.95 shipping & handling 
charge.

 

Q

 

Is my Connectix QuickCam scriptable? 

 

A

 

 Yes, you can control QuickPICT using AppleScript. 

 

Q

 

 Is there a developer’s program for the Connectix QuickCam? 

 

A

 

 Yes. More information about the developer’s program can be obtained at 
http://www.connectix.com.  You may contact also Connectix Developer Relations by 
sending email to developer@connectix.com. 

 

Q

 

What accessories are available for QuickCam?

 

A

 

 Connectix sells a Camera Tripod (7" high with tilt/swivel) for $14.95. To order, or for 
more information, call Connectix at 1-800-950-5880 (North America only). 
Connectix also sells A/B switchers for your serial port as well as extension cables.
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SUPPORT AND 
SALES

 

Using QuickCam  is easy and fun. In the unlikely event that you have a problem with the 
QuickCam hardware, or with the software supplied by Connectix, please read this section 
first.

 

Contacting Connectix Support

 

■

 

If you have questions or problems with QuickCam, contact 
us by telephone, by fax, or via electronic mail. Try the 
following first:

 

1.  

 

Read  this  manual. It may only take a few moments to get the answers you need. Also, 
check the “ReadMe” file. This has information on known problems and solutions.

 

2.  

 

Write down the events that lead to the problem. Have you changed anything in your com-
puter recently?

Have the following available when you contact Technical Support:

 

■

 

Registration number—on the Registration Card

 

■

 

Software version number—on the installer

 

■

 

Macintosh model—located in “About This Macintosh…”

 

■

 

Apple System software version—in “About This Macintosh…”
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Support and Sales

Connectix Technical Support can be contacted at the following online services:

 

Online Service Mail Address

 

 

 

Forum Location

 

■

 

America On-Line Connectix Keyword = Connectix

 

■

 

CompuServe 75300, 1546 Go CONNECTIX

You can also contact us on the World Wide Web, or by e-mail, fax, or phone:

 

■

 

WWW:

 

http://www.connectix.com

 

■

 

E-mail

 

: cqcmsupp@connectix.com (Color QuickCam)

qcmsupp@connectix.com (Grayscale QuickCam)

 

■

 

Phone:

 

415-571-5100 (Grayscale and Color QuickCam)

 800-950-5858 (Color QuickCam)

 800-950-5880 (Grayscale QuickCam)

 

■

 

Fax:

 

415-571-5195

 

Contacting Connectix Sales

 

Contact Connectix Sales for more information about QuickCam volume sales (site license, 
50-user, and 10-user), QuickCam for Windows, or other Connectix products.

 

Internet:

 

 sales@connectix.com

 

FAX:

 

 415-571-0850

 

Phone:

 

 800-950-5880 or 415-571-5100  (Sales only)

 

Contacting Connectix Support in Europe

 

Country Telephone Number

 

Germany 0130-823887 (toll-free)

France 05-917943 (toll-free)

Britain 0800-966199 (toll-free)

Holland 20-5814384

For all other European countries, dial +31-20-5814385. This number is in Holland, 
however information will be provided in English.

 

European Addresses

 

Mailing:

 

 SEI, Attn: Connectix, Orlyplein 85, 1043 DS Amsterdam, The Netherlands

 

FAX:

 

 Fax questions to: +31-20 581 4380

 

■

 

Internet:

 

 For e-mail use the internet address: CONNECTX@NL.SYKES.COM
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E

 

 WARRANTY

 

The QuickCam hardware is warranted to be free from defects in materials and workmanship 
for a period of one year from the date of purchase. During the warranty period, Connectix will, 
at its option, either repair or replace products which prove to be defective. This warranty is 
void if the FCC label has been removed or if Connectix determines that the user has opened 
the camera’s plastic case.

Should Connectix be unable to repair or replace the product within a reasonable amount of 
time, a refund of the purchase price may be given upon return of the product.

The warranty on your QuickCam hardware does not apply to defects or damage resulting 
from:

 

■

 

Improper installation

 

■

 

Unauthorized modification

 

■

 

Removal of the FCC label

 

■

 

Opening the case

 

■

 

Misuse

Before returning a failed unit, you must obtain a Return Merchandise Authorization (RMA) 
from Connectix.
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